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BAB II  

KAJIAN TENTANG BELAJAR, MEDIA PEMBELAJARAN, ADOBE 

FLASH, MEDIA POWER POINT, HASIL BELAJAR, RUANG 

LINGKUP BIOLOGI 

A. Pengertian Belajar 

Terdapat banyak definisi yang menjelaskan mengenai pengertian belajar. 

Slameto (2010: 2) berpendapat bahwa belajar ialah suatu proses usaha yang 

dilakukan seseorang untuk memperoleh suatu perubahan tingkah laku yang 

baru secara keseluruhan, sebagai hasil pengalamannya sendiri dalam interaksi 

dengan lingkungannya. Banyak sekali jenis dan perubahan yang terjadi dalam 

diri seseorang, oleh karena itu tidak semua perubahan yang terjadi dalam diri 

seseorang tersebut merupakan perubahan dalam arti belajar. 

Bimo Walgito (2010: 185) menyatakan bahwa belajar merupakan suatu 

proses yang mengakibatkan adanya perubahan perilaku. Surya (2003: 11) 

mengemukakan bahwa belajar adalah suatu proses yang dilakukan oleh 

individu untuk memperoleh suatu perubahan perilaku yang baru secara 

keseluruhan, sebagai hasil dari pengalaman individu itu sendiri dalam interaksi 

dengan lingkungannya. Belajar akan lebih efektif apabila dilakukan dalam 

suasana yang menyenangkan dan dapat menghayati objek pembelajaran secara 

langsung. 

Definisi-definisi belajar menurut para ahli tersebut mengacu pada definisi 

belajar sebagai suatu proses perubahan tingkah laku individu melalui interaksi 

dengan lingkungannya. Di dalam interaksi inilah terjadi serangkaian 
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pengalaman-pengalaman belajar. Pengalaman tersebut menghasilkan suatu 

perubahan perilaku di dalam kepribadian manusia, dan perubahan tersebut 

ditampakkan dalam bentuk peningkatan kualitas dan kuantitas tingkah laku 

seperti peningkatan kecakapan, pengetahuan, sikap, kebiasaan, pemahaman, 

keterampilan, dan daya pikir. Sehingga, jika di dalam suatu proses belajar 

peserta didik tidak mendapatkan suatu peningkatan kualitas dan kuantitas 

kemampuan, dapat dikatakan orang tersebut sebenarnya belum mengalami 

proses belajar atau dengan kata lain peserta didik mengalami kegagalan di 

dalam proses belajar. Berdasarkan pengertian  belajar yang dikemukakan para 

ahli di atas, maka dapat disimpulkan belajar merupakan suatu upaya yang 

sengaja untuk memperoleh perubahan tingkah laku, baik yang berupa 

pengetahuan maupun keterampilan yang ditunjukkan dengan penampilan atau 

perilaku. 

B. Media Pembelajaran 

Kata media berasal dari bahasa Latin yaitu jamak dari kata medium yang 

secara harfiah berarti perantara atau pegantar. Media pembelajaran adalah 

sarana pendidikan yang dapat digunakan sebagai perantara dalam proses 

pembelajaran untuk mempertinggi efektivitas dan efisiensi dalam mencapai 

tujuan pengajaran (Sanaky, 2009: 4). Wagiran (2009: 3) mengartikan media 

pembelajaran sebagai segala sesuatu yang dapat digunakan untuk menyalurkan 

pesan dari pengirim ke penerima pesan sehingga dapat merangsang pikiran, 

perasaan, perhatian, dan minat serta perhatian siswa untuk meningkatkan 

kualitas proses belajar mengajar. Berdasarkan pengertian yang dikemukakan 
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oleh Sanaky dan Wagiran tersebut maka dapat disimpulkan media 

pembelajaran merupakan segala sesuatu yang digunakan dalam kegiatan 

pembelajaran agar dapat merangsang pikiran, perasaan, minat, dan perhatian 

siswa sehingga proses interaksi antara guru dengan siswa dapat berlangsung 

secara tepat. 

Terdapat beberapa faktor penyebab penggunaan media pembelajaran jarang 

dilakukan oleh guru diantaranya, yaitu guru merasa repot karena penggunaan 

media memerlukan persiapan terlebih dahulu, media itu canggih dan mahal, 

ketidakbiasaan guru dalam mengoperasikan software, ketidaktersedianya 

media pelajaran di sekolah, kebiasaan menikmati metode ceramah.  

Salah satu gambaran yang paling banyak dijadikan acuan sebagai landasan 

teori penggunaan media dalam proses belajar adalah Dale’s Cone of 

Experience (Kerucut Pengalaman Dale). Merupakan elaborasi yang rinci dari 

konsep tiga tingkatan pengalaman langsung (konkret), kenyataan yang ada di 

lingkungan kehidupan seseorang kemudian melalui benda tiruan, sampai 

kepada lambang verbal (abstrak). Semakin ke atas di puncak kerucut semakin 

abstrak media penyampaian pesan itu. Pernyataan tersebut dapat digambarkan 

dengan menggunakan Kerucut Pengalaman Edgar Dale (Arsyad, 2013: 13). 

 
Gambar 2.1 Kerucut Pengalaman Edgar Dale 

Sumber: Bagus dwiradyan.wordpress.com 



14 

 

 
 

Media pembelajaran mempunyai beberapa ciri. Gerlach dan Ely (dalam 

Arsyad, 2013: 15) mengungkapkan ciri media pendidikan yang layak 

digunakan dalam pembelajaran, yaitu sebagai berikut: 

1. Fiksatif : Media pembelajaran mempunyai kemampuan untuk 

merekam, menyimpan, dan merekontruksi suatu peristiwa/objek. 

2. Manipulatif : Kejadian yang memakan waktu berhari-hari dapat 

disajikan kepada siswa dalam waktu singkat. 

3. Distributif : Memungkinkan berbagai objek ditransportasikan melalui 

suatu tampilan yang terintegrasi dan secara bersamaan objek dapat 

menggambarkan kondisi yang sama pada siswa dengan stimulus 

pengalaman yang relatif sama dengan kejadian itu. 

Hujair Sanaky (2009: 4) menyebutkan bahwa tujuan media pembelajaran 

adalah sebagai berikut: 

1. Mempermudah proses pembelajaran di kelas 

2. Meningkatkan efisiensi proses pembelajaran 

3. Menjaga relevansi antara materi pelajaran dengan tujuan belajar 

4. Membantu konsentrasi pembelajar dalam proses pembelajaran. 

5. Fungsi media pembelajaran. 

Azhar Arsyad (2011 : 25-27) mengemukakan beberapa manfaat dari 

penggunaan media pembelajaran di dalam proses belajar mengajar sebagai 

berikut:  

1. Memperjelas penyajian pesan dan informasi sehingga dapat 

memperlancar dan meningkatkan proses dan hasil belajar  
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2. Meningkatkan dan mengarahkan perhatian anak sehingga menimbulkan 

motivasi belajar  

3. Media pengajaran dapat mengatasi keterbatasan indera, ruang dan 

waktu 

4. Memberikan kesamaan pengalaman tentang peristiwa dilingkungan 

mereka dan menimbulkan presepsi yang sama.  

Media merupakan salah satu sarana untuk meningkatkan kagiatan belajar 

mengajar. Media yang ada pada saat ini sangat beraneka ragam, karena 

beraneka ragamnya media, maka menurut Azhar Arsyad (2002: 72-74) ada 

beberapa kriteria yang patut diperhatikan dalam memilih media, yaitu sebagai 

berikut: 

1. Sesuai dengan tujuan yang ingin dicapai. Media dipilih berdasarkan 

tujuan instruksional yang telah ditetapkan yang secara umum mengacu 

kepada salah satu atau gabungan dari dua atau tiga ranah kognitif, 

afektif dan psikomotor. 

2. Tepat untuk mendukung isi pelajaran yang sifatnya fakta, konsep, 

prinsip, atau generalisasi. 

3. Praktis, luwes dan bertahan. Jika tidak tersedia waktu, dana atau 

sumber dana lainnya untuk memproduksi tidak perlu dipaksakan. 

Media yang mahal dan memakan waktu yang lama untuk 

memproduksinya bukanlah jaminan sebagai media yang terbaik. 

Kriteria ini menuntun para guru atau instruktur untuk memilih media 

yang ada, mudah diperoleh atau mudah dibuat sendiri oleh guru. 
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4. Guru terampil dalam menggunakannya. Apapun media itu, guru harus 

mampu menggunakannya dalam proses pembelajaran. Nilai dan 

manfaat amat ditentukan oleh guru yang menggunakannya. 

5. Pengelompokkan sasaran. Media yang efektif untuk kelompok besar 

belum tentu sama efektifnya jika digunakan pada kelompok kecil atau 

perorangan, ada media yang tepat untuk jenis kelompok besar, 

kelompok sedang maupun kecil atau perorangan.  

6. Mutu teknis pengembangan visual, baik gambar atau fotograf harus 

memenuhi persyaratan teknis tertentu, misalnya visual pada slite harus 

jelas dan informasi atau pesan yang ditonjolkan dan ingin disampaikan 

tidak boleh terganggu oleh elemen lain yang berupa latar belakang.  

Hujair Sanaky (2009: 5-6) menyebutkan bahwa dalam menentukan media 

yang akan digunakan pada proses pembelajaran di kelas terdapat beberapa hal 

yang harus dipertimbangkan, pertimbangan media yang akan digunakan dalam 

pembelajaran harus sesuai dengan hal-hal berikut ini: 

1. Tujuan pembelajaran 

2. Bahan pelajaran 

3. Metode mengajar 

4. Ketersediaan alat yang 

dibutuhkan 

5. Pribadi pengajar 

6. Minat dan kemampuan pembelajar 

7. Situasi pembelajaran yang sedang 

berlangsung  

Dengan demikian, keterkaitan antara media pembelajaran dengan tujuan, 

materi, metode dan kondisi pembelajar harus menjadi perhatian dan pertimbangan 

pengajar untuk memilih dan menggunakan media dalam proses pembelajaran di 
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kelas, sehingga media yang digunakan lebih efektif dan efisien untuk mencapai 

tujuan pembelajaran, sebab media pembelajaran tidak dapat berdiri sendiri, tetapi 

terkait dan memiliki hubungan secara timbal balik dengan empat aspek tersebut. 

C. Adobe Flash 

Flash merupakan salah satu program pembuatan animasi yang sangat handal 

dibandingkan dengan program lain, karena ukuran file dari animasi Flash relatif 

kecil (Daryanto, 2008: 9). Menurut Hersaputri (dalam Anis Julaika Wati, 2014: 2) 

media Adobe Flash dapat membantu guru untuk mempresentasikan, menjelaskan 

mata pelajaran, dan memberikan informasi secara jelas sehingga materi atau 

informasi yang disajikan akan lebih mendetail. Adobe Flash mampu membantu 

dan memudahkan pemakai dalam menyelesaikan pekerjaan, seperti, animasi, 

presentasi, membuat CD interaktif, dll (Sutopo, 2003: 3-13). Berdasarkan 

pengertian yang telah diungkapkan oleh para ahli maka Adobe Flash adalah salah 

satu perangkat lunak komputer yang dapat digunakan untuk melakukan desain dan 

membangun perangkat presentasi yang dapat digunakan sebagai media 

pembelajaran. Proyek yang dibangun dengan Flash bisa terdiri atas teks, gambar, 

animasi sederhana, video, atau efek-efek khusus lainnya. 

Daryanto (2008: 14) menyebutkan bagian-bagian penting yang terdapat dalam 

area kerja pada Adobe Flash yaitu: menu, toolbox, timeline, stage, dan panel. 

1. Menu 

Menu pada Adobe Flash terdiri dari: file, edit, view, insert, modify, text, 

commands, control, debug, window, dan help. Pada setiap menu terdapat 

sub-menu yang akan muncul ketika menu tersebut diklik satu kali.  
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2. Toolbox 

Dalam toolbox terdapat komponen-komponen penting diantaranya: tools, 

view, colors, dan options. Toolbox berperan untuk memanipulasi atau 

modifikasi objek dalam stage. 

3. Timeline 

Timeline terdiri dari beberapa layer. Layer digunakan untuk menempatkan 

satu atau beberapa objek dalam stage agar dapat diolah dengan objek lain. 

Setiap layer terdiri dari frame-frame yang digunakan untuk mengatur 

kecepatan animasi.  

4. Stage 

Stage disebut juga layar. Stage digunakan untuk memainkan objek-objek 

yang akan diberi animasi. Dalam stage dapat membuat gambar, teks, 

memberi warna dan sebagainya. 

5. Panel 

Beberapa panel penting yang terdapat dalam Adobe Flash diantaranya 

adalah properties, filters and parameters, action, library, color, dan align, 

info and transform. 

a. Panel properties, filters and parameters 

Panel properties, filters and parameters digunakan untuk mengatur 

ukuran background, kecepatan animasi dan lain-lain.  

b. Panel Actions 

Panel actions digunakan untuk menulis scipt atau bahasa 

pemrograman flash (Actions Script). Script dapat diketikkan secara 
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langsung pada layer actions atau menggunakan bantuan yang 

disediakan oleh Adobe Flash. 

c. Panel Library 

Panel Library merupakan panel yang digunakan untuk menyimpan 

objek-objek berupa graphic atau gambar, button atau tombol, movie, 

dan suara, baik yang dibuat langsung pada stage ataupun hasil proses 

impor dari luar stage.  

d. Panel Color 

Panel Color merupakan panel yang digunakan untuk memilih warna 

yang digunakan dalam pembuatan objek-objek pada stage. Ada dua 

sub-panel yaitu: color mixer dan color swatches.  

e. Panel Align, Info and Transform 

Panel ini digunakan untuk mengatur posisi objek jika ingin diletakkan 

pada tengah stage, sebelah kiri atau kanan dan lain-lain. Dengan Panel 

ini objek juga dapat diputar dengan menggunakan transform. 

Keunggulan yang dimiliki software ini apabila dibandingkan dengan software 

animasi yang lain diantaranya adalah program yang berorientasi objek (OOP), 

mampu membuat gambar berbasis vektor, mampu membuat animasi gambar, 

dapat digunakan sebagai software pembuat situs web, dsb. Hartato (2011: 18) 

menyebutkan terdapat beberapa kelebihan media flash dalam dunia pendidikan, 

antara lain: 

1. Membuat media ajar yang interaktif dan animatif dari segi tampilan dan 

juga dalam segi tujuan, 
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2. Penyajiannya menarik  karena ada permainan warna, huruf, dan animasi, 

baik animasi teks maupun gambar atau photo. Dengan adanya media yang 

menarik akan membuat minat belajar siswa menjadi meningkat, 

3. Meningkatkan motivasi belajar siswa, 

4. Pesan informasi secara audio visual mudah dipahami peserta didik. 

Cara membuat presentasi multimedia menggunakan Adobe Flash menurut 

Hendri yaitu sebagai berikut: 

1. Medesain background 

2. Membuat halaman intro 

a. Tambahkan layer dan beri nama teks, mask, tombol, musik, dan action 

b. Klik laer teks lalu buat kalimat yang dibutuhkan dihalaman kerja 

dengan menggunakan text tool pada toolbox. 

c. Animasikan teks tersebut dengan pilih layer mask > buat objek persegi 

empat warna puth diluar halaman kerja dengan menggunakan 

rectangel tool pada toolbox. Klik kanan ada frame 1 layer mask dan 

pilih creat motion tween.kemudian klik frame 25 pada layer mask 

tekan F6. Lakukan hal yang sama pada layer bacground, tekx, tombol, 

musik, dan action dengan mengklik frame 25> F6.  Klik frame 25 

pada layer mask > tarik objek persegi empat warna putih yang ada 

diluar halaman kerja sehingga menutupi teks yang dibuat sebelumnya. 

Kemudian pilih kembali layer mask > klik kanan > pilih mask. Test 

movie dengan cara tekan Ctrl + enter. 
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d. Pada Layer Tombol, Tambahkan tombol untuk pergi ke halaman 

selanjutnnya . Klik menu Window > Common Libraries > Button. 

Klik tahan lalu geser  button yang para readers pilih pada lembar kerja 

di Frame 25 Layer Tombol. 

e. Seleksi Tombol/Button yang ada pada lembar kerja, tekan F9 lalu 

ketikkan Action Script on (release) {gotoAndPlay("Scene 2",1);} 

f. Klik Layer Musik > Klik Menu File > Import > Import to Library 

> Cari file Musik yang para readers senangi > Pada library klik tahan 

geser music yang sudah di import tersebut pada halaman kerja.  

g. lakukan pengaturan dengan cara klik frame 1 pada layer Musik > Klik 

properties kemudian lakukan pengaturan seperti pada gambar berikut. 

3. Membuat halaman isi 

a. Klik menu Insert > Scene. 

b. Bekerja pada Scene 2. Tambahkan Layer dan berikan 

Nama Background, Teks, Tombol dan Action. 

c. Mulailah bekerja pada Layer Bacground. Tambahkan Background 

yang sudah kita buat tadi dibagian Mendesain Background. Pada 

Libraries Klik Tahan Geser Background pada lembar kerja. 

Kemudian seleksi background yang sudah ada pada lembar kerja lalu 

lakukan pengaturan pada properties dengan memasukan ukuran W: 

800 H: 600 X: 0 Y: 0. 

d. Pada Layer Teks tambahkan Teks atau Isi Materi yang akan 

dipresentasikan dengan menggunakanText Tool pada Toolbox. 
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Contoh “Multimedia Secara “Etimologi“ Di Artikan Sebagai, “Multi“ 

(Banyak) “Medium“ (Prantara Media)”  

e. Tambahkan Tombol pada Layer Tombol dengan cara yang sama 

seperti dibagian halaman intro. Berikan Action Script, on (release) 

{gotoAndPlay("Scene 1",1);} 

f. Pada Frame 1 Layer Action berikan Action Script  dengan cara klik 

frame 1 layer Action > F9 > Ketikkan Action Script stop(); 

g. Test Movie dengan cara tekan Ctrl + Enter. 

D. Media Power Point 

Media Power Point merupakan media elektronik yang digunakan untuk 

merancang dan mempresentasikan suatu media dalam bentuk slide (Suarna, 

2008:9). Media power point adalah suatu software yang digunakan untuk 

membantu dalam menyusun sebuah presentasi sehingga gagasan yang 

disampaikan lebih menarik dan jelas. Power Point dapat menyimpan presentasi 

dalam beberapa format, yakni sebagai berikut: 

1. PPT (Powerpoint Presentation), yang merupakan data biner dan 

tersedia dalam semua versi PowerPoint (termasuk Powerpoint 12) 

2. PPS (Powerpoint Show), yang merupakan data biner dan 

tersedia dalam semua versi PowerPoint (termasuk Powerpoint 12) 

3. POT (Powerpoint Template), yang merupakan data biner dan 

tersedia dalam semua versi PowerPoint (termasuk Powerpoint 12) 

4. PPTX (Powerpoint Presentation), yang merupakan data dalam 

bentuk XML dan hanya tersedia dalam Powerpoint 12. 
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Menurut (Miarso, 2001: 164) kelebihan dari media program powerpoint ini 

sebagai berikut: 

1. Penyajiannya menarik karena ada permainan warna, huruf dan animasi, 

baik ani2masi teks maupun animasi gambar atau foto.  

2. Lebih merangsang anak untuk mengetahui lebih jauh informasi tentang 

bahan ajar yang tersaji. 

3. Memberikan kemungkinan pada penerima pesan untuk mencatat.  

4. Pesan informasi secara visual mudah dipahami peserta didik. 

5. Tenaga pendidik tidak perlu banyak menerangkan bahan ajar yang sedang 

disajikan.  

6. Dapat diperbanyak sesuai kebutuhan, dan dapat dipakai secara berulang-

ulang.  

7. Dapat disimpan dalam bentuk data optik atau magnetik 

(CD/disket/flashdisk), sehingga paraktis untuk di bawa ke mana-mana. 

Media hanyalah sebagai alat bantu.  

Media pembelajaran program power point selain mempunyai kelebihan juga 

mempunyai kekurangan-kekurangan. Kekurangan media power point menurut 

Miarso (2001: 140) diantaranya adalah: 

1. Penggadaanya mahal, dan tidak semua sekolah dapat memiliki.  

2. Memerlukan perangkat keras (hardware) yaitu komputer dan LCD untuk 

memproyeksikan pesan.  

3. Memerlukan persiapan yang matang, bila menggunakan teknik-teknik 

penyajian (animasi) yang kompleks.  
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4. Diperlukan ketrampilan khusus dan kerja sistematis untuk 

menggunakannya.  

5. Menuntut ketrampilan khusus untuk menuangkan pesan atau ide-ide yang 

baik pada desain program komputer microsoft powerpoint, sehingga 

mudah dicerna oleh penerima pesan.  

6. Bagi pemberi pesan yang tidak memiliki ketrampilan menggunakan dapat 

memerlukan operator atau pembantu khusus. Harus ada persiapan yang 

cukup menyita waktu dan tenaga. 

Langkah-langkah membuat presentasi pada media power point yaitu sebagai 

berikut: 

1. Buka Microsoft PowerPoint lalu pilih menu design, pilih theme yang 

disukai. 

2. Setelah memilih theme, silahkan ganti tulisan click to add title dengan 

judul presentasi dan click to add subtitle dengan deskripsinya. 

3. Untuk menambah slide bisa di lakukan di menu home kemudian klik new 

slide lalu pilih layout yang dibutuhkan 

4. Untuk menambahkan animasi pada pergantian slide sobat bisa 

melakukannya di menu animation 

5. Untuk menambahkan efek animasi pada teks atau gambar dalam 

presentasi, silahkan klik costume animation kemudian klik teks yang akan 

di kasih animasi, lalu pilih add effect. 

6. Klik Slide Show untuk melihat hasil keseluruhan (full screen) 

7. Jika presentasi sudah di buat silahkan disimpan dengan cara klik ctrl+S. 
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E. Hasil Belajar 

Oemar Hamalik (2008: 159) mengungkapkan bahwa evaluasi hasil belajar 

adalah seluruh kegiatan pengukuran (pengumpulan data dan informasi), 

pengolahan, penafsiran, dan pertimbangan untuk membuat keputusan tentang 

tingkat hasil belajar yang dicapai oleh siswa setelah melakukan kegiatan belajar 

dalam upaya mencapai tujuan pembelajaran yang ditetapkan. Sudjana (2013: 22) 

mengemukakan hasil belajar adalah kemampuan-kemampuan yang dimiliki siswa 

setelah ia menerima pengalaman belajarnya. Selain itu Purwanto (2011: 46) 

mengungkapkan bahwa hasil belajar adalah perubahan perilaku peserta didik 

akibat belajar. 

 Berdasarkan pengertian yang telah diungkapkan para ahli di atas dapat 

disimpulkan bahwa hasil belajar adalah kemampuan yang dimiliki peserta didik 

setelah mengikuti proses pembelajaran. Jadi hasil belajar berkaitan erat dengan 

proses belajar dan merupakan satu bagian yang tak terpisahkan dalam proses 

belajar.  

Menurut Gagne (dalam Sudjana, 2010: 3) ada lima kemampuan hasil belajar, 

yaitu: 

1. Informasi verbal 

2. Keterampilan intelektual 

3. Strategi kognitif 

4. Sikap 

5. Keterampilan motoris 

Menurut Muhibbin Syah (2010: 145) secara garis besar faktor-faktor yang 

mempengaruhi hasil belajar dapat dibedakan menjadi tiga macam, yaitu: 
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1. Faktor internal (faktor dari dalam diri siswa), yakni keadaan/kondisi 

jasmani dan rohani siswa; 

2. Faktor eksternal (faktor dari luar siswa), yakni kondisi lingkungan di 

sekitar siswa; 

3. Faktor pendekatan belajar (approach to learning), yakni jenis upaya 

belajar siswa yang meliputi strategi dan metode yang digunakan siswa 

untuk melakukan kegiatan pembelajaran materi-materi pelajaran. 

Hasil belajar dapat diukur dengan melakukan penilaian. Dengan demikian 

penilaian adalah proses memberikan atau menentukan nilai kepada objek tertentu 

berdasarkan suatu kriteria tertentu (Sudjana, 2010:3). 

F. Analisis dan Pengembangan Materi Pelajaran yang Diteliti 

1. Karakteristik Materi 

Berdasarkan kurikulum 2013, materi ruang lingkup biologi termasuk KD 

3.1. Memahami tentang ruang lingkup biologi (permasalahan pada berbagai 

obyek biologi dan tingkat organisasi kehidupan),  metode ilmiah dan  prinsip 

keselamatan kerja berdasarkan pengamatan dalam kehidupan sehari-hari. Serta 

termasuk KD 4.1. Menyajikan data tentang objek dan permasalahan biologi 

pada berbagai tingkatan organisasi kehidupan sesuai dengan metode ilmiah 

dan memperhatikan aspek keselamatan kerja serta menyajikannya dalam 

bentuk laporan tertulis. 

2. Bahan dan Media 

Bahan ajar yang digunakan dalam penelitian ini yaitu buku dan internet. 

Bahan ajar tersebut merupakan bahan rujukan yang dapat digunakan siswa 
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selama proses pembelajaran untuk membantu siswa dalam mencari informasi 

yang berkaitan dengan materi ruang lingkup biologi. 

Pada penelitian ini, selain menggunakan bahan ajar proses pembelajaran 

juga lebih ditekankan kepada penggunaan media yang diberikan oleh guru 

serta keaktifan siswa. Pemanfaatan media dalam proses pembelajaran dapat 

membantu siswa untuk lebih memahami materi yang disampaikan. Media 

pembelajaran yang digunakan dalam penelitian ini yaitu media power point 

dan media pembelajaran berbasis adobe flash. 

3. Strategi Pembelajaran 

Penggunaan media power point serta media pembelajaran berbasis adobe 

flash merupakan strategi pembelajaran yang digunakan dalam penelitian ini. 

Penggunaan media mampu menampilkan slide presentasi yang menarik dan 

dapat membantu guru dalam menyampaikan materi sehingga siswa lebih 

mudah memahami materi yang disampaikan sehingga dapat meningkatkan 

hasil belajar siswa. 

Selain penggunaan media, dalam proses pembelajaran juga siswa diminta 

untuk mengamati salah satu tingkat organisasi kehidupan, yaitu organisasi 

tingkat sel menggunakan mikroskop cahaya, dan siswa di minta untuk 

mempresentasikan hasil pengamatannya. Proses pengamatan dan presentasi 

tersebut bertujuan agar siswa lebih aktif dalam menyampaikan pendapat, 

mengetahui organisme pada tingkat sel yang tidak bisa dilihat secara langsung 

dengan mata telanjang, serta bertujuan untuk melihat aspek psikomotor yang 

dimiliki oleh siswa. 
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4. Sistem Evaluasi 

Teknik evaluasi hasil belajar siswa dalam penelitian ini dilakukan dengan 

menggunakan tes. Tes yang dilakukan adalah tes awal (pretest) dan tes akhir 

(posttest) yang berupa soal pretest dan posttest. Tes tersebut mencakup ranah 

kognitif, dan bentuk instrumennya berupa soal pilihan ganda yang berjumlah 

30 soal dengan lima options. Soal-soal yang diberikan untuk tes awal dan tes 

akhir dibuat sama agar kemampuan siswa sebelum dan sesudah diberikan 

perlakuan dapat terlihat jelas. 

G. Ruang Lingkup Biologi 

Istilah biologi berasal dari bahasa Yunani, yaitu dari kata bios dan kata logos. 

Bios artinya hidup dan logos artinya ilmu. Jadi, biologi adalah ilmu tentang 

makhluk hidup dan berbagai proses kehidupan. Biologi mempelajari tentang 

makhluk hidup, bagaimana interaksinya satu sama lain, dan bagaimana 

interaksinya dengan lingkungan. Karakteristik ilmu biologi ditentukan oleh objek 

yang dipelajari dan permasalahan yang dikaji. 

1. Makhluk hidup dan Ciri - Cirinya 

Biologi merupakan salah satu ilmu pengetahuan alam. Antara biologi 

dengan ilmu pengetahuan alam lainnya dapat saling berkaitan dan melahirkan 

ilmu pengetahuan yang baru seperti yang disebutkan Anonim (2015:1) berikut 

ini : 

a. Biofisika merupakan perpaduan antara biologi dengan fisika. 

b. Biokimia merupakan perpaduan antara biologi dengan kimia. 

c. Radiobiologi merupakan perpaduan antara biologi dengan fisika. 
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Objek yang dipelajari dalam ilmu biologi adalah makhluk hidup. Makhluk 

hidup mempunyai ciri-ciri hidup sehingga dapat dibedakan dengan objek sains 

lainnya. (Anonim, 2015:1) menyebutkan ciri-ciri hidup antara lain sebagai 

berikut: 

a. Makhluk hidup disusun oleh sel.  

b. Makhluk hidup melakukan proses metabolisme, ekskresi, bergerak, 

dan reproduksi. 

c. Makhluk hidup menunjukkan iritabilitas (peka terhadap rangsangan). 

d. Makhluk hidup mengalami pertumbuhan dan perkembangan. 

e. Makhluk hidup membutuhkan makanan (nutrisi). 

f. Makhluk hidup mampu menyesuaikan diri (beradaptasi) dengan 

lingkungan. 

Makhluk hidup mempunyai struktur yang sangat terorganisasi. Struktur 

kehidupan tersusun mulai dari yang paling sederhana, yaitu molekul, sel, 

jaringan, organ, individu, populasi, komunitas, sampai yang paling luas dan 

kompleks, yaitu bioma. Oleh karena itu, kajian terhadap makhluk hidup 

dilakukan secara hierarkis, mulai dari tingkat molekul hingga bioma. 

 

2. Cabang – Cabang Biologi 

Dengan semakin berkembangnya pengetahuan, biologipun semakin 

berkembang dan memunculkan cabang-cabang biologi, antara lain seperti 

pada tabel 2.1 berikut ini : 
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TABEL 2.1: CABANG-CABANG BIOLOGI 

Cabang 

Biologi 
Pengertian 

Anatomi Tentang struktur bagian tubuh makhluk hidup 

Bakteriologi  Tentang bakteri  

Bioteknologi  Tentang teknik memanfaatkan organisme untuk 

menghasilkan suatu produk yang bermanfaat bagi 

manusia 

Botani  Tentang beraneka ragam tumbuh-tumbuhan 

Ekologi  Tentang hubungan makhluk hidup 

Embriologi  Tentang pertumbuhan dan perkembangan embrio 

Entomologi  Tentang serangga 

Evolusi  Tentang asal usul makhluk hidup dan berbagai 

perubahan yang terjadi secara perlahan-lahan dibumi 

Fisiologi  Tentang fungsi alat-alat tubuh makhluk hidup 

Genetika  Tentang penurunan sifat makhluk hidup kepada 

keturunannya 

Histologi  Tentang jaringan tubuh 

Imunologi Tentang sistem kekebalan tubuh 

Mikologi  Tentang jamur/ fungi 

Mikrobiologi  Tentang organisme kecil yang tidak dapat dilihat oleh 

mata secara langsung 

Morfologi  Tentang bentuk dan struktur makhluk hidup 

Ornitologi  Tentang hewan golongan aves 

Patologi Tentang penyakit dan pengaruhnya bagi manusia 

Sanitasi Tentang kesehatan lingkungan 

Sitologi Tentang sel 

Virologi Tentang virus 

Zoologi  Tentang beraneka ragam hewan  

(Anonim, 2015:2) 

3. Struktur Organisasi Kehidupan 

Berdasarkan tingkat organisasi kehidupan, objek biologi adalah kehidupan 

pada berbagai tingkat struktur. Irnaningtyas (2014: 5-6) menyebutkan tingkat 

organisasi kehidupan tersebut yaitu; molekul, sel, jaringan, organ, sitem organ, 

individu, populasi, komunitas, ekosistem ,bioma. 
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a. Tingkat Molekul 

Setiap inti sel makhluk hidup memiliki molekul organic yang berperan 

mengendalikan struktur dan fungsi setiap sel. Inti sel juga membawa 

informasi genetik yang diturunkan. Gen tersusun oleh molekul organik 

yang berupa DNA. DNA mempunyai kemampuan replikasi yaitu 

membentuk dirinya sendiri yaitu DNA, juga kemampuan membentuk 

molekul lain yaitu RNA melalui transkripsi. RNA berperan sebagai 

pelaksana sintesis protein.  

b. Tingkat Sel 

Sel merupakan unit kehidupan yang terkecil. Makhluk hidup 

uniseluler, seperti Protozoa, bakteri, dan alga, melangsungkan 

metabolismenya di dalam sebuah sel, karena adanya organel-organel 

yang menjalankan fungsi metabolisme. Makhluk hidup multiseluler, 

seperti tumbuhan dan hewan, disusun oleh bermacam-macam sel yang 

memiliki bentuk dan fungsi yang berbeda.  

c. Tingkat Jaringan 

Jaringan merupakan kumpulan sel yang mempunyai bentuk dan fungsi 

sama. Tubuh hewan terdiri dari bermacam-macam jaringan, misalnya 

jaringan otot, darah, atau epidermis. Porifera dan Coelenterata 

merupakan contoh makhluk hidup tingkat organisasi jaringan yang 

paling sederhana. Porifera dan Coelenterata memiliki dua lapisan sel 

pembentuk tubuh (diploblastik), yaitu lapisan terluar (ektoderm) dan 

lapisan terdalam (endoderm).  
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d. Tingkat Organ 

Organ merupakan kumpulan jaringan dengan fungsi tertentu. Contoh 

organ dalam tubuh manusia antara lain jantung, paru-paru, dan 

lambung. Adapun organ tumbuhan contohnya akar, batang, daun, 

bunga, dan buah.  

e. Tingkat Sistem Organ 

Sistem organ disusun oleh organ-organ yang saling berinteraksi dalam 

melaksanakan fungsi di dalam tubuh. Sebagai contoh system peredaran 

darah manusia, yang terdiri atas jantung dan pembuluh darah, 

berfungsi untuk mengedarkan darah ke seluruh tubuh.  

f. Tingkat Individu 

Di tingkat individu, berlangsung mekanisme kompleks yang terjadi 

karena koordinasi dan regulasi bermacam-macam sistem tubuh. 

Contohnya manusia merupakan individu yang terdiri atas bermacam-

macam sistem organ, antara lain sistem gerak, sistem sirkulasi, sistem 

pencernaan, sistem respirasi, sistem ekskresi, sistem reproduksi, dan 

sistem imun.  

g. Tingkat Populasi 

Kumpulan individu yang berada pada waktu dan tempat yang sama 

disebut populasi. Dilingkungan sekitar kita terdapat bermacam-macam 

populasi, misalnya populasi rumput, populasi pohon kelapa, populasi 

burung merpati, populasi cacing tanah, dan sebagainya.  
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h. Tingkat Komunitas 

Kumpulan populasi pada waktu dan tempat yang sama disebut 

komunitas. Misalnya komunitas padang rumput, yang terdiri atas 

populasi rumput, populasi belalang, populasi kupu-kupu, populasi 

cacing tanah, populasi alang-alang, dan sebagainya. 

i. Tingkat Ekosistem 

Ekosistem adalah interaksi antara populasi-populasi penyusun 

komunitas dengan lingkungan abiotiknya (misalnya sinar matahari, 

tanah, air, dan udara). 

j. Tingkat Bioma 

Kumpulan ekosistem yang melingkupi wilayah yang luas akan 

membentuk bioma. Irnaningtyas (2014: 6) menyebutkan terdapat 

beberapa contoh bioma besar yang ada di bumi dari khatulistiwa 

sampai ke kutub adalah sebagai berikut: 

1) Bioma gurun 

2) Bioma padang rumput 

3) Bioma hutan gugur 

4) Bioma hutan hujan tropis 

5) Bioma taiga 

6) Bioma tundra 

Pemberian nama bioma dilihat dari tumbuhan yang dominan. 

Misalnya, disebut bioma padang rumput karena tumbuhan yang 

dominan adalah rumput. Suatu bioma memiliki iklim tertentu sehingga 

terdapat tipe tumbuhan dan hewan khas yang mampu beradaptasi di 

lingkungan tersebut. 
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4. Manfaat Mempelajari Biologi  

Peranan biologi dalam kehidupan memberikan dampak positif dan negatif. 

Biologi sangat besar manfaatnya dalam meningkatkan kesejahteraan manusia, 

seperti menolong manusia dari wabah penyakit dan kelaparan. Biologi dapat 

diterapkan dalam berbagai bidang, seperti kedokteran, industri, pertanian, 

peternakan, dan lain-lain. Kemajuan biologi akan berdampak negatif apabila 

manusia melakukan eksploitasi secara besar-besaran terhadap sumber daya 

alam hayati maupun sumber daya alam non hayati, menggunakan pestisida 

secara berlebihan, hanya melestarikan dan mengembangkan bibit unggul saja, 

serta menggunakan senjata biologi. 

5. Metode Ilmiah sebagai Pendekatan untuk Mempelajari Biologi 

Metode ilmiah (scientifie method) ialah proses berpikir untuk memecahkan 

suatu masalah dengan sistematis. Menurut Aryulina (2007:22) metode ilmiah 

mengandung empat hal pokok, yaitu sebagai berikut: 

a. Metode ilmiah merupakan proses berpikir untuk memecahkan 

masalah. 

b. Pada metode ilmiah, proses berpikir dilakukan secara sistematis. 

c. Metode ilmiah didasarkan pada data empiris. 

d. Pada metode ilmiah, proses berpikir dilakukan secara terkontrol dan 

terjaga (sadar). 

Biologi dapat dipelajari melalui suatu pendekatan ilmiah, yaitu metode 

ilmiah. Metode ilmiah merupakan suatu prosedur (urutan langkah) yang harus 

dilakukan untuk melakukan suatu proyek ilmiah (sciece project). Ada pun 



35 

 

 
 

orang yang melakukan penelitian disebut peneliti. Aryulina (2007: 22) 

menyebutkan langkah-langkah metode ilmiah sebagai berikut: 

a. Memilih masalah 

b. Mengumpulkan  informasi 

awal 

c. Merumuskan masalah 

d. Merumuskan hipotesis 

e. Melalukukan eksperimen 

f. Mengolah dan menganalisis data 

g. Membuat kesimpulan 

h. Mempublikasikan  hasil penelitian 

6. Keselamatan Kerja di Laboratorium 

Bagi orang yang bekerja dengan agen biologi yang berbahaya, misalnya 

virus atau bakteri patogen, harus menerapkan biosafety. Biosafety adalah 

usaha yang dilakukan agar orang yang bekerja dengan bahan biologi yang 

berbahaya terlindungi dari bahaya bahan biologi yang ditanganinya. 

Irnaningtyas (2014: 15-18) menyebutkan petunjuk untuk bekerja di ruang 

laboratorium yang perlu diperhatikan sebagai berikut: 

a. Persiapkan diri dengan baik 

1) Bacalah semua prosedur dan informasi tentang keselamatan kerja 

sebelum mulai praktikum. 

2) Perhatikan pengarahan dari petugas lab atau guru sebelum mulai 

bekerja. 

3) Lakukan hanya eksperimen yang diminta oleh guru. 

4) Ikuti semua instruksi lisan dan tertulis, mintalah bantuan jika kamu 

memerlukan bimbingan atau bantuan. 
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b. Petunjuk keselamatan kerja umum 

1) Pastikan meja praktikum bersih dari benda-benda yang tidak 

diperlukan. 

2) Saat bekerja, janganlah sambil bercanda gurau atau main-main. 

3) Jangan memakai peralatan jika belum mengerti cara 

menggunakannya. 

4) Jangan bekerja sendirian di laboratorium. 

5) Jika ada barang laboratorium yang rusak saat di pakai segera 

laporkan ke pembimbing. 

6) Jangan meninggalkan percobaan yang sedang berjalan tanpa 

pengawasan. 

7) Buanglah sampah dan limbah laboratorium dengan tepat. 

8) Bersihkan meja lab sebelum meninggalkan lab. 

c. Mencegah terjadi paparan 

1) Tidak makan, minum, mengunyah permen karet, atau memasang 

lensa kontak di laboratorium. 

2) Ikatlah rambut yang panjang. Jangan gunakan perhiasan panjang 

yang dapat tersangkut di peralatan laboratorium. 

3) Kenakan jas lab dan sepatu untuk menutupi kulit dan melindungi 

dari bahaya terpercik cairan. 

4) Kenakan sarung tangan tahan panas untuk melindungi tangan 

ketika memanaskan zat. 

5) Gunakan pelindung wajah seperti masker atau kacamata pelindung. 
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d. Simbol-simbol bahan kimia berbahaya 

TABEL 2.2 : SIMBOL BAHAN KIMIA BERBAHAYA 

Simbol Sifat Bahan Perlakuan 

 

Flammable / Mudah 

terbakar, contoh: 

minyak tanah, kerosin, 

alkohol, dan bensin. 

Jauhkan dari api, 

sumber panas, dan 

percikan api. 

 

Oxidizing / Oksidatif, 

contohnya kalium 

permanganat. 

Jauhkan dari bahan-

bahan yang mudah 

terbakar 

 

Explosif / mudah 

meledak, 

Contohnya: campuran 

hidrogen dan oksigen.  

Jauhkan dari bahan 

mudah terbakar, 

benturan dan suara 

kuat. 

 

Korosif, contohnya 

asam sulfat, asam nitrat, 

dan sodium hidroksida. 

Hindari menghirup uap, 

terkena kulit dan mata. 

Gunakan sarung tangan 

dan pelindung mata 

 

Harmful irritant/bahaya, 

iritasi, contohnya 

peridin, ammonia dan 

benzyl klorida. 

Hindari kontak dengan 

tubuh atau hindari 

menghirup.  

 

Toxic / beracun, 

contohnya merkuri, 

sianida, dan gas klorin. 

Hindari kontak dengan 

kulit, terhirup, atau 

tertelan karena bersifat 

mematikan. 

(Irnaningtyas, 2014:16) 

 


